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ABSTRACT
The structural equation modelling with partial least squares estimation (PLS-SEM) has been used in a wide 
variety of research areas, increasing exponentially the number of articles published using this method. There 
are several reasons for this to be happening, but one of them is the fact that the SmartPLS software facilitated 
the use of PLS-SEM. This article aims to present seven didactic examples with real data sets available to those 
who want to learn or teach PLS-SEM, dealing with such topics as measurement model evaluation, structural 
model evaluation, multicollinearity, second-order latent variable, mediation, moderation with numerical and 
categorical variables (MGA - multi-group analysis).
Keywords: Structural Equations Modeling. SmartPLS 3. Partial Least Squares.
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INTRODUCTION

The structural equation modeling with partial least squares estimation  
(PLS-SEM) in the social sciences and behavior areas has been shown as an 
excellent possibility for the evaluation of  relations among constructs (or 
factors, components, latent variables, unobserved variables , subscales, 
etc.), since it is robust to the lack of  multivariate normality and is feasible 
for small samples (less than ~ 100 cases). These aspects are very present 
in the use of  attitude scales. There is an alert that is worth repeating: do 
not justify using SmartPLS 3 only because the sample is small (GUIDE; 
KETOKIVI, 2015). The complexity of  the model, the lack of  multivariate 
normality of  the data or the need to use constructs with formative indica-
tor are other reasons to justify the use of  PLS-SEM.

In addition, when collecting data with attitude scales it should be 
borne in mind that many responses will not be of  good quality for a vari-
ety of  reasons, and thus the minimum sample size (RINGLE et al., 2014a, 
2014b) should be doubled or triplicate to prevent “low” quality data from 
jeopardizing the analysis and results.

PLS-SEM is a “flexible” technique capable of  estimating complex 
models (many constructs, many variables, many causal relationships be-
tween constructs – arrows – and formative models), so it has a great “tun-
ing” with field knowledge and the nature of  the problems and data coming 
from human social relations.

It fits very well in situations where the theory that underlies causal 
relationships does not yet have great “sedimentation” and can be used in a 
more “exploratory” way. In this sense, the complexity of  the problems and 
the social processes does not allow (yet) to have theories with a degree of  
generalisation as in other areas of  knowledge, such as in Physics and Chem-
istry, for example, a fact that reinforces the use of  the statistical technique 
in question.

The primary goal of  this paper is to present some advanced and com-
plementary techniques and to serve as reference material for those interest-
ed in learning, teaching and using the structural equation modelling with 
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partial least squares estimation (PLS-SEM), so all data and models were 
available in Bido and Silva (2019).

It should be noted that in Ringle et al. (2014a, 2014b) there are more 
general and primary explanations (formative and reflective indicators, en-
dogenous and exogenous variables, sample size definition, use of  the soft-
ware, etc.) than the present article, in this sense, it is recommended as a 
preliminary reading. 

The focus of  this article is more on the use of  SmartPLS 3 software 
than on previous activities and decisions (definitions, hypotheses, etc.). In 
this way, the present work was structured as seven examples, and to make 
the best use of  this material, it is suggested a complete reading followed by 
the modelling of  each example from the datasets (.csv or .txt). 

Because SmartPLS 3 has many outputs and space in the articles is 
always very limited, formatting the results as explained in this article can 
be a useful exercise.
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EXAMPLE 1 - CONFIRMATORY COMPONENT ANALYSIS (CCA)

In the structural equation modelling covariance based (LISREL, AMOS, 
EQS, SAS, Stata, lavaan) it is recommended to run the two-step analysis 
(ANDERSON; GERBING, 1988), first the CFA (confirmatory factor analy-
sis), which is a model in which all the latent variables (VL) are correlated 
with each other, to evaluate the measurement model and then another mo-
del including the structural relations (hypotheses).

In the context of  PLS-SEM this approach is not recommended be-
cause the algorithm is “partial” (the iteration occurs in stages: measure-
ment à structural à measurement à .until there is the convergence, that 
is, the results of  a step are practically equal the previous one). This means 
that if  the two-step approach is used, it may happen that a suitable model 
is obtained in the first stage (CCA), but inadequate in the second step be-
cause the structural part is different from that used in the CCA. Thus, it is 
recommended to run the structural model directly in PLS-SEM, even if  the 
measurement evaluation is done separately from the structural model.

Therefore, this model (CCA) has not been widely used, but it can be 
useful when the objective is only to evaluate the LV measurement model 
and to obtain factor scores for use in further analyses.

Specification
To exemplify confirmatory component analysis (CCA), the DLOQ (Di-
mensions of  the Learning Organization Questionnaire) model of  Marsick 
and Watkins was used, which has been replicated so many times that it had 
a special number in Advances in Developing Human Resources (v.15, n.2, 
2013) and in Brazil the DLOQ-A (A of  abbreviated) was validated, which 
instead of  using six indicators by LV, uses three indicators by LV) by Mene-
zes et al. (2011).

From this comment, it is concluded that SEM-CB (SEM covariance 
based, with software like LISREL, AMOS, EQS, Mplus and lavaan) is the 
most appropriate method, but it was decided to use this model as an exam-
ple because the data were available and because it is an illustrative example 
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of  the decisions that are made during the analysis (do not do this in your 
article - use PLS-SEM, when the correct would be SEM covariance based). 
In Figure 1 are the seven dimensions of  DLOQ-A, which contents are ex-
plained in the article by Menezes et al. (2011, p.27-29).

Figure 1 Indicators by latent variable

Note 1: Indicators available in Menezes et al. (2011).

Estimation
In the SEM-CB all exogenous LV are correlated by default, but in PLS-SEM 
it is necessary to include these relations (Figure 2), because the algorithm 
is “partial”, that is, it needs the measurement and structural relations to 
have the iterations (BIDO et al., 2010, p.252). The results presented in the 
arrows (path coefficients) will not be used at all in this analysis, therefore, 
no matter the sequence in which the LV is connected.



issn 2358-0917

470 ADMINISTRAÇÃO: ENSINO E PESQUISA RIO DE JANEIRO V. 20 No 2 P. 465–513 MAY-AUG  2019

diógenes de souza bido & dirceu da silva 

Figure 2 Connecting all latent variables to each other

Note 1: All LVs must be connected to all others, and although the direction of  the arrows 

is not important here, there can be no feedbacks (non-recursive model). In this model it 

was started from the LV “cont_learn”, sending arrows to all the others, then “dialog_in-

quiry”, continuing counterclockwise until all LV have six arrows connected to them (arri-

ving or leaving). Observed or measured variables (reflective indicators or scale items) were 

hidden (hide/show function) to make the figure clearer.

In the PLS algorithm we select the option “factor weighting scheme” 
(Figure 3) and from the output is analysed the correlations between the LV 
and the factor loadings (outer loadings and cross-loadings).
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Figure 3 Weighting scheme in the PLS algorithm for the CCA

Note: In the SmartPLS 3 Menu use: Calculate> PLS algorithm> Factor> Start calculation

The bootstrap is used to obtain the p-values of  the correlations be-
tween the LVs and the factor loadings in SmartPLS 3 as follows:

• Calculate > Bootstrapping > Complete bootstrapping (Figure 4) > 
Start Calculation

• Output of  the Bootstrapping > Quality Criteria > Latent variable cor-
relations (Note 2 in the footnote in Table 1)

• Output of  the Bootstrapping > Final Results > Outer loadings (Foot-
note in Table 2)
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Figure 4 Bootstrapping to obtain the p-values

Note 1: In versions prior to SmartPLS 3.2.8 there were options for dealing with signal 
changes, which caused bimodality in bootstrapping results, but of  the three options, two 
of  them (no sign and individual sign changes) sometimes did not resolve or worsen the 
problem, so they have been withdrawn in the most current version.
Note 2: For each round of  the bootstrapping algorithm, the results will be somewhat dif-
ferent (standard error, t-value, p-value) because it is based on random resampling and with 
replacement, but if  a coefficient is significant (p <0.05) this should not change from one 
round to another. Compare the p-values of  Table 4 with yours (these are different rounds 
of  bootstrapping).

Evaluation and reporting
In the CCA, only the measurement model (there is no structural model) 
is evaluated, what is done in the following section, based on the estimated 
model in the SmartPLS 3 software (RINGLE et al., 2015).

SmartPLS 3 produces several results, but some work is needed to 
format them. Two tables (Table 1 and 2) are required to evaluate the mea-
surement model. The first is used for the analysis at the LV level and the 
second for the analysis at the indicator’s level, it is recommended that they 
are evaluated simultaneously.

Basic option, when 
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Table 1 was prepared as follows:
• Output PLS algorithm > Quality Criteria:

• Discriminant validity > Fornell-Larcker Criterion > Excel format
• Paste in an Excel spreadsheet 
• Construct reliability and validity > Excel format
• Paste in the same Excel spreadsheet (anywhere)
• Copy the reliability results, which were pasted > Right-Click 

( just below the correlation matrix) > Paste special > Trans-
pose

• Number the LVs and replace the names in the header with 
numbers.

• Include note 1 in the footnote.

• Output Bootstrapping > Quality Criteria:
• Latent variable correlations 
• Include note 2 in the footnote.

Table 1 Matrix of  correlations between latent variables (n = 200)

Latent variables 1 2 3 4 5 6 7

1 - team_learning 0.831            
2 - empower 0.644 0.840          
3 - des_vis_sistem_org 0.706 0.773 0.844        
4 - sys_connection 0.755 0.727 0.752 0.884      
5 - leadership 0.673 0.758 0.740 0.742 0.831    
6 - dialog_inquiry 0.752 0.690 0.724 0.756 0.726 0.825  
7 - sys_capture_share 0.663 0.675 0.717 0.662 0.648 0.675 0.868
               
Cronbach’s Alpha 0.777 0.791 0.799 0.860 0.777 0.766 0.836
rho_A 0.778 0.793 0.812 0.865 0.784 0.766 0.840
Composite reliability (CR) 0.870 0.877 0.881 0.915 0.870 0.865 0.902
Average Variance Extracted (AVE) 0.691 0.705 0.713 0.781 0.690 0.680 0.753

Note 1: The values in the diagonal are the square root of  the AVE.
Note 2: All correlations are significant at 1%.
Note 3: Here the three reliability measures were maintained to show the possibilities, but 
it is recommended to use composite reliability, as was done in Tables 5 and 7.

Figure 4 Bootstrapping to obtain the p-values

Note 1: In versions prior to SmartPLS 3.2.8 there were options for dealing with signal 
changes, which caused bimodality in bootstrapping results, but of  the three options, two 
of  them (no sign and individual sign changes) sometimes did not resolve or worsen the 
problem, so they have been withdrawn in the most current version.
Note 2: For each round of  the bootstrapping algorithm, the results will be somewhat dif-
ferent (standard error, t-value, p-value) because it is based on random resampling and with 
replacement, but if  a coefficient is significant (p <0.05) this should not change from one 
round to another. Compare the p-values of  Table 4 with yours (these are different rounds 
of  bootstrapping).

Evaluation and reporting
In the CCA, only the measurement model (there is no structural model) 
is evaluated, what is done in the following section, based on the estimated 
model in the SmartPLS 3 software (RINGLE et al., 2015).

SmartPLS 3 produces several results, but some work is needed to 
format them. Two tables (Table 1 and 2) are required to evaluate the mea-
surement model. The first is used for the analysis at the LV level and the 
second for the analysis at the indicator’s level, it is recommended that they 
are evaluated simultaneously.

Basic option, when 
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Table 2 was prepared as follows:
• Output PLS algorithm > Quality Criteria:

• Discriminant validity > Cross-loading > Excel format
• Paste in an Excel spreadsheet (Figure 5)

• Note that the indicators are listed in alphabetical order and 
not by LV, so the format in Figure 5b still needs to be rear-
ranged.

• Move the lines so that the indicators of  the same LV stay 
together and the table should stand as a “ladder” (Table 2).

• Output Bootstrapping > Final Results:
• Outer loadings
• Include note 1 in the footnote.

Figure 5 Output PLS algorithm 

 (a) SmartPLS 3 (b) Excel

team_learning empower

VX11
VX13
VX14
VX17
VX19
VX23
VX24
VX25
VX26
VX29
VX3
VX30
VX33

0.631
0.601
0.866
0.803
0.824
0.548
0.611
0.565
0.588
0.525
0.612
0.502
0.650

0.656
0.543
0.560
0.555
0.484
0.529
0.618
0.606
0.823
0.860
0.651
0.836
0.699

team_learning empower

VX11 0.631 0.656

VX13 0.601 0.543

VX14 0.866 0.560

VX17 0.803 0.555

VX19 0.824 0.484

VX23 0.548 0.529

VX24 0.611 0.618

VX25 0.565 0.606
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Table 2 Matrix of  factor loadings (crossloadings) (n=200)
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VX14
VX17
VX19
VX26
VX29
VX30
VX33
VX36
VX37
VX41
VX42
VX43
VX3
VX5
VX7

VX11
VX13
VX8

VX23
VX24
VX25

0.866
0.803
0.824
0.588
0.525
0.502
0.650
0.435
0.674
0.651
0.622
0.724
0.612
0.448
0.596
0.631
0.601
0,624
0.548
0.611
0.565

0.560
0.555
0.484
0.823
0.860
0.836
0.699
0.592
0.657
0.639
0.601
0.683
0.65 1
0.608
0.626
0.656
0.543
0.491
0.529
0.618
0.606

0.593
0.624
0.538
0.654
0.667
0.621
0.868
0.807
0.856
0.632
0.641
0.717
0.633
0.539
0.660
0.696
0.547
0.528
0.603
0.672
0.588

0.671
0.641
0.564
0.609
0.639
0.578
0.675
0.518
0.692
0.872
0.875
0.904
0.671
0.577
0.595
0.623
0.631
0.613
0.528
0.583
0.608

0.586
0.574
0.513
0.685
0.637
0.578
0.684
0.508
0.662
0.612
0.639
0.713
0.836
0.813
0.842
0.634
0.611
0.542
0.508
0.598
0.576

0.603
0.633
0.641
0.591
0.600
0.543
0.674
0.494
0.645
0.652
0.631
0.718
0.735
0.449
0.595
0.790
0.856
0.827
0.549
0.626
0.578

0.533
0.631
0.480
0658
0.575
0.452
0.673
0.577
0.562
0.600
0.528
0.623
0.550
0.402
0.640
0.655
0.465
0.530
0.861
0.887
0.855

Note 1: All factor loadings are significant at 1%.

Note 2: High cross-loadings were formatted in red and italic.

With the results formatted in Tables 1 and 2, the evaluation of  the 
measurement model is done in the following sequence (*):

• Convergent validity: 
• At the indicator’s level: outer loading > 0.7 (Table 2)
• At the LV level: AVE > 0.5 (Table 1)
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• Discriminant validity: 
• At the LV level: √ AVE > r

VL
 (Table 1)

• At the indicator’s level: outer loadings > cross-loadings (hor-
izontally and vertically in Table 2)

• Reliability
• CR > 0.7 (Table 1)

(*) This sequence is suggested because one of  the assumptions for the re-
liability assessment is that the construct is unidimensional, that is, its con-
vergent and discriminant validity must be adequate, so if  there is a problem 
of  convergent or discriminant validity, it should not be continued to the 
reliability assessment.

Table 1 shows that for all LV, AVE > 0.5 and √AVE > r
VL

, as well as 
CR > 0.7, therefore, the convergent validity, discriminant and reliability are 
adequate. However, the correlations between all LV are very high (about 
0.65 to 0.75), which makes sense in the present model, since all LV are di-
mensions of  the learning culture (MENEZES et al., 2011).

In Table 2 it can be observed that the factor loadings (in bold) are 
greater than the cross-loadings (“off-diagonal” loadings), confirming the 
discriminant validity, yet there are high cross-loadings (some of  them about 
of  0.7), which is consistent with the high correlations between LV (Table 
1), but these high values raise some doubts:

• If  the HTMT (heterotrait-monotrait ratio) matrix is used to eval-
uate the discriminant validity of  this model, it is observed that 
some desattenuated correlations are greater than 0.85 (poten-
tial discriminant validity problem), but there are desattenuated 
correlations higher than 0.90, which indicates a lack of  discrimi-
nant validity by this criterion (HAIR Jr. et al., 2016). This matrix 
is in the: Output PLS algorithm > Discriminant Validity > hetero-
trait-monotrait ratio. How does such a replicated scale still have 
this kind of  problem? The focus of  this article is not on the the-
oretical discussion of  each model, but some answers would be:
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• The LVs are organisational-level concepts, measured by individ-
uals from the same organisation, so the unit of  analysis would 
be the individual’s perception of  an organisational phenomenon, 
which is more homogeneous than if  the unit of  analysis were at 
the level of  the organisations themselves (each case equals one 
organisation)

• The same person evaluating several constructs at the same time 
and with same assertive formats, there is a potential of  the com-
mon method bias (CMB) (MACKENZIE; PODSAKOFF, 2012).

• Although the DLOQ and DLOQ-A are very replicated scales, 
in general, only Cronbach’s alpha is analysed before the factor 
scores are generated by averaging the items. Both Menezes et 
al. (2011) and Yang (2003) had problems with full scale (DLOQ) 
when evaluating convergent and discriminant validity.

• These LV will be used in the next examples (structural models), 
then the consequences of  keeping them separated or grouped 
will become more evident. 

In this example, all factor loadings were high (greater than 0.8), but 
there are cases where recommended minimum values are not reached in 
the first round. Table 3 suggests some measures to improve the fit of  the 
model.
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Table 3 What to do when validity criteria are not met

Results Providence Comment

Some  
loadings < 0.7

AVE > 0.5
CR > 0.7

Keep the model

Whenever possible, it is recommended 
to maintain the maximum of  indicators 
in the model so as not to jeopardise the 
validity of  content [1]

Some  
loadings < 0.7

AVE < 0.5
CR > 0.7

Delete indicator 
with lower loading 
and run again

These thresholds are not inflexible; 
sometimes it is better to keep more in-
dicators, even with AVE just below 0.5 
(LITTLE et al., 1999)

√AVE < r
VL

Eliminating indi-
cators with lower 
loadings (increases 
the AVE)

Eliminating indi-
cators with high 
cross-loadings (the 
correlation between 
the LV decreases)

(i) If  both providences are not enough, 
it is concluded that there is not discrim-
inant validity between the LVs and it is 
decided to: (i) eliminate one of  them 
from the model or
(ii) Grouping them into a single LV, 
which may be inappropriate because 
it would require a revision of  the con-
ceptual definitions to maintain content 
validity.

Note 1: When eliminating many indicators from the measurement, other problems can 

occur: chance capitalization raising doubts about the replicability of the results in a new 

sample, makes comparison with results of other studies unfeasible, and jeopardize the 

application of the scale in future studies (DEVELLIS, 2016; NETEMEYER et al., 2003). 

Hair Jr. et al. (2010, p.690) give a recommendation for SEM-covariance based, which 

applies to PLS-SEM: if the modification made in the model is not small (less than 20% of 

indicators were deleted), it should be replicated in another sample.

Legend: AVE = average variance extracted.

 CR = composite reliability.

 r
VL

  correlation between LV.
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EXAMPLE 2 - SIMPLE STRUCTURAL MODEL 

This example is based on the previous one, which was added a dependent 
variable, financial performance (Figure 6), there are now structural rela-
tionships (hypotheses H1 to H7).

Specification 
DLOQ and DLOQ-A contain the seven dimensions used in Example 1 and 
two other performance dimensions, so the specification of  the model pre-
sented in Figure 6 is based on the same theoretical framework (MENEZES 
et al., 2011).

Figure 6 Structural model

Note: Indicators available in Menezes et al. (2011).
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Estimation
In the PLS algorithm, select the “path weighting scheme” (Figure 7), and 
from the output it will use the results: Collinearity Statistics (VIF), f  Square 
and R square, to format the table with the results of  the structural model 
(Table 4).

Figure 7 Weighting scheme in the PLS algorithm for the structural model

The bootstrapping algorithm is used in the same way as in Example 1 
(Figure 4), and from the output it will use the results: Path coefficients and 
Path coefficients Histogram, to format the Table 4 with the results of  the 
structural model.

Evaluation and reporting
The evaluation of  the model should be done in two separate sections: (i) 
one for the measurement model (in the same way as was done in Exercise 
1, but will not be presented here because of  space constraints); (ii) and ano-
ther for the structural model, which is the focus of  this example.

Before starting the formatting of  the results, it is necessary to eval-
uate if  the bootstrapping histograms are unimodal (Figure 8), if  they are 
not, we must go back to the beginning and assess the presence of  outliers, 
indicators with little variability, binary indicators etc. 
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Figure 8 Histogram from bootstrapping

Note: A histogram for each structural coefficient is shown in bootstrapping output. If this 

chart presents bimodality, we must verify if there are outliers or LV measured by a few 

dichotomous indicators.

These graphs are presented in bootstrapping output: Histograms > Path coefficients his-

tograms.

The results can be presented in the figure or table form. Figure 9 
may be a good choice for presentation purposes in the form of  PPT and 
group discussion, but for article it takes up a lot of  space and contains little 
information (in SmartPLS 3 it is possible to select what should be displayed 
in the arrows and in the LV, for example, factor loadings, structural coef-
ficients, t-value, p-value, R² or adjusted R²). Table 4 is the recommended 
format for articles, dissertations, and theses.
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Figure 9 Results of  the structural model in bootstrapping

Note: Values outside the parentheses are standardised structural coefficients (be-

tas), and the values within the parentheses are p-values (there is an option to pre-

sent the t-values).

SmartPLS 3 contains many results of  the structural model, to facili-
tate their presentation, it is recommended to format a table as follows:

• Output Bootstrapping > Final Results:
• Path coefficients > Excel format
• Paste in an Excel spreadsheet 
• Delete column “Sample Mean (M)”
• Include columns for Hypothesis, VIF, f² and R² adjusted

• Output PLS algorithm > Quality Criteria:
• Copy the results to the Excel spreadsheet (Table 4): 
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 ○ Collinearity Statistics (VIF) > Inner VIF Values
 ○ f  Square 

• Reorder the rows by grouping them by endogenous variable 
(unnecessary in this example because there is only one en-
dogenous variable) and paste the adjusted R² values for each 
endogenous variable.

• Reorder the lines to put the hypotheses in a sequence.

With the results formatted in Table 4, it is easier to analyse them 
simultaneously, taking into account the following criteria:

• Multicollinearity
• If  VIF > 5 consider excluding predictors or group them into a 

second-order LV (HAIR Jr. et al., 2016). 
• Relative importance of  predictors: 

• Effect size: f² = 0.02 = small; f² = 0.15 = medium; f² = 0.35 = 
large (COHEN, 1988)

• Structural coefficients (such as beta of  the regression)
• Correlations between exogenous and endogenous variables: 

comparing the correlations with the structural coefficients 
gives a more complete evaluation of  the relative importance 
of  the predictor.

• Explained variance of  endogenous variables 
• R² = 2% = small; R² = 13% = medium; R² = 26% = large  

(COHEN, 1988)

Table 4 shows that only two of the seven hypotheses were con-
firmed (p <0.05) and the effect size (f²) is small in both relations, although 
the explained variance is large (adjusted R² = 40.6%). The inconsistency 
between these results can be explained by multicollinearity, even if VIF 
is below 5:

• The correlations between the predictors and endogenous LV 
vary from 0.48 to 0.59 (values are very close to those shown in 
Table 5a), i.e., from the bivariate point of  view all the predictors 



issn 2358-0917

484 ADMINISTRAÇÃO: ENSINO E PESQUISA RIO DE JANEIRO V. 20 No 2 P. 465–513 MAY-AUG  2019

diógenes de souza bido & dirceu da silva 

T
ab

le
 4

 R
es

ul
ts

 o
f 

th
e 

st
ru

ct
ur

al
 m

od
el

 (n
=

20
0)

St
ru

ct
ur

al
 r

el
at

io
ns

Hypothesis

VIF

f
2

Structural 
coefficient

Standard 
error

t-value

p-value

R
2
 ajusted

co
nt

_l
ea

rn
 - >

 fi
na

nc
ia

l_
pe

rf
di

al
og

_i
nq

ui
ry

 - >
 fi

na
nc

ia
l_

pe
rf

te
am

_l
ea

rn
in

g 
- >

 fi
na

nc
ia

l_
pe

rf
sy

s_
ca

pt
ur

e_
sh

ar
e 

- >
 fi

na
nc

ia
l_

pe
rf

em
po

w
er

 - >
 fi

na
nc

ia
l_

pe
rf

sy
s_

co
nn

ec
tio

n 
- >

 fi
na

nc
ia

l_
pe

rf
le

ad
er

sh
ip

 - >
 fi

na
nc

ia
l_

pe
rf

H
1(

+
)

H
2(

+
)

H
3(

+
)

H
4(

+
)

H
5(

+
)

H
6(

+
)

H
7(

+
)

3.
28

1
3.

37
0

3.
02

0
2.

51
0

3.
23

1
3.

66
0

3.
53

1

0.
00

3
0.

04
6

0.
01

9
0.

03
3

0.
00

2
0.

01
9

0.
01

5

-0
.0

70
0.

29
9

0.
18

1
0.

21
7

0.
06

0
0.

20
2

-0
.1

72

0.
10

2
0.

10
7

0.
10

8
0.

07
2

0.
10

1
0.

11
8

0.
12

4

0.
69

2
2.

79
6

1.
68

4
2.

99
7

0.
59

0
1.

70
8

1.
38

3

0.
48

9
0.

00
5

0.
09

2
0.

00
3

0.
55

5
0.

08
8

0.
16

7

0.
40

6

N
ot

e 
1:

 p
-v

al
ue

s e
st

im
at

ed
 b

y 
bo

ot
st

ra
pp

in
g 

w
ith

 5
00

0 
re

pe
tit

io
ns

.

N
ot

e 
2:

 If
 th

e 
ta

bl
e 

ha
s m

an
y 

co
lu

m
ns

 a
nd

 sm
al

l f
on

t s
iz

e,
 so

m
e 

sim
pl

ifi
ca

tio
ns

 c
an

 b
e 

m
ad

e,
 fo

r e
xa

m
pl

e:
 (i

) d
el

et
e 

th
e 

V
IF

 c
ol

um
n 

an
d 

in
cl

ud
e 

a 
fo

ot
no

te
 re

po
rt

in
g 

on
ly

 th
e 

la
rg

es
t v

al
ue

 o
f 

V
IF

; (
ii)

 e
xc

lu
de

 th
e 

t-v
al

ue
 c

ol
um

n 
an

d 
re

ta
in

 o
nl

y 
p-

va
lu

e.

N
ot

e 
3:

 T
hi

s e
xa

m
pl

e 
do

es
 n

ot
 h

av
e 

co
nt

ro
l v

ar
ia

bl
es

, b
ut

 if
 it

 h
ad

, i
t i

s r
ec

om
m

en
de

d 
to

 p
re

se
nt

 th
e 

re
su

lts
 o

f 
3 

m
od

el
s: 

(1
st
) o

nl
y 

w
ith

 

th
e 

co
nt

ro
l v

ar
ia

bl
es

 a
nd

 th
e 

en
do

ge
no

us
 v

ar
ia

bl
es

, (
2nd

) c
om

pl
et

e 
m

od
el

 w
ith

 th
e 

va
ria

bl
es

 c
on

tr
ol

, (
3rd

) c
om

pl
et

e 
m

od
el

 w
ith

ou
t t

he
 

co
nt

ro
l v

ar
ia

bl
es

.

Le
ge

nd
: f

² =
 e

ffe
ct

 si
ze

 o
f 

C
oh

en
 (1

98
8)

, V
IF

 =
 v

ar
ia

nc
e 

in
fla

ct
io

n 
fa

ct
or

.



ADMINISTRAÇÃO: ENSINO E PESQUISA RIO DE JANEIRO V. 20 No 2 P. 465–513 MAY-AUG  2019 485

smartpls 3: specification, estimation, evaluation and reporting 

are important since any predictor alone explains approximately 
25% of  the endogenous LV variance. 

• Although the correlation between the predictors and the endog-
enous variable were all positive and about 0.5, it can be seen in 
Table 4 that the structural coefficient in H7 was non-significant 
(p> 0.05) and its negative result indicates suppression, which is 
one of  the symptoms of  multicollinearity (COHEN et al., 2003).

• A VIF equal to 3.66 means that 72.7% of  the variance of  a pre-
dictor is explained by the other predictors (there is an overlap 
between them). 

• The correlations between the predictors (Table 5a) range from 
0.64 to 0.77, that is, higher than their correlations with the en-
dogenous VL.

To address this inconsistency, Hair Jr. et al. (2016) recommend elim-
inating predictors or grouping them into a second-order VL, which was 
done by Menezes et al. (2011) and will be developed in the next example.
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EXAMPLE 3 - STRUCTURAL MODEL WITH SECOND-ORDER LA-
TENT VARIABLE (REPEATING INDICATORS)

From the empirical point of  view, it has been observed in the previous 
examples that the seven LV of  the DLOQ are highly correlated, and from 
the theoretical point of  view the seven dimensions have to do with the le-
arning culture, therefore, to use it as the common cause among the seven 
dimensions makes sense from both points of  view.

Specification
A second-order latent variable is measured by two or more first-order LVs 
and is thus modelled when using SEM based on covariance, but in the case 
of  PLS-SEM, if  the LV has no measured variables connected to it does not 
start the iterations. In these cases, one of  the options is to reuse the indica-
tors of  the first-order LV in the second-order LV.

This option is recommended when the number of  indicators per LV 
is approximately equal (in this example, the seven first-order LVs have three 
indicators each); otherwise, the LV that has more indicators will result in a 
larger factor loading simply because it has more repeated indicators in the 
second-order LV.

The relationships between the second-order LV and its dimensions 
(first-order LV) should be interpreted and used as factor loadings (not hypo-
theses). In this model, the only hypothesis (structural relationship) is be-
tween the learning culture and performance (Figure 10).
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Figure 10 Specification of  the structural model in SmartPLS 3

Note 1: Learning Culture is a second-order LV.

Note 2: The LV Learning Culture contains 21 indicators (the indicators of  the 7 LV were 

repeated in it), but were hidden to make it easier to see the model.

Estimation
The estimation (PLS algorithm and bootstrapping) is done exactly as was 
done in example 2, but a care that must be taken is that the relationships 
between the second-order VL and its first-order LV will be in the output of  
structural relations (path coefficients ), so a formatting job is required (to 
separate these results), as well as to calculate AVE (average variance extrac-
ted) and CR (composite reliability) by hand, because SmartPLS 3 does the-
se calculations with the indicators that were repeated in the second-order 
LV (Figure 11).
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Figure 11 AVE and CR calculation for the second-order LV in the Excel 
spreadsheet

Note: To calculate the AVE = H10 = SUMSQ(G2:G8)/7

 To calculate the CR = SUM(G2:G8)^2/(SUM(G2:G8)^2+SUM(H2:H8))

Evaluation and reporting
For models with second-order LV, it is recommended to present the results 
in three steps: (i) measurement model of  the  first-order LV (as was done in 
Tables 1 and 2), (ii) measurement model of  the LVs that are in the structu-
ral model (in Table 5), (iii) structural model as was done in Table 4 (below, 
in Table 6).

The formatting of  the tables is done in the same way as was done 
in the previous examples, but now has one more step, which is explained 
below:

• Output PLS algorithm > Quality Criteria:
• Discriminant validity > Fornell-Larcker Criterion > Excel format

• Paste in the Excel spreadsheet and include the AVE and CR 
values as done in the previous examples, pass the endoge-
nous variables to the end of  the table (last row and column 
on the right).

• Copy and paste this table into another Excel spreadsheet
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• In the first table: delete the second-order LV
• In the second table: remove the first-order LVs that were 

used to measure the second-order LV and correct the AVE 
values (square root of  the AVE in the diagonal) and the CR 
for the second-order LV.

Table 5 Matrix of  correlations between LV’s (n = 200)

(a) First-order LV 1 2 3 4 5 6 7 8

1 - team_learning 0.832              

2 - deleg_pod_resp 0.643 0.840            

3 - empower 0.704 0.772 0.844          

4 - sys_connection 0.754 0.726 0.751 0.884        

5 - leadership 0.671 0.757 0.738 0.742 0.831      

6 - cont_learn 0.752 0.688 0.721 0.755 0.723 0.825    

7 - sys_capture_share 0.662 0.674 0.716 0.661 0.647 0.672 0.868  

8 - financial_perf 0.549 0.508 0.559 0.477 0.471 0.588 0.565 0.885
                 
Composite  
reliability (CR)

0.870 0.878 0.882 0.915 0.870 0.865 0.902 0.915

Average variance 
extracted (AVE)

0.692 0.705 0.713 0.781 0.690 0.681 0.753 0.782

(b) LV of the structural model 1 2

1 - LEARN_CULTURE 0.868  

2 - financial_perf 0.612 0.885
     
Composite reliability (CR) 0.955 0.915

Average variance extracted (AVE) 0.753 0.782

Note 1: The values in the diagonal are the square root of  the AVE.

Note 2: All correlations are significant at 1%. This information is displayed in the bootstra-

pping output when the “complete” option is run.

Note 3: Culture_Apren is a second-order LV.
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In order to evaluate the cross-loadings (as was done in Table 2), the 
second-order LV and the repeated indicators should be excluded. It was not 
presented here due to space constraints.

The structural model is now quite simple, although at first glance it 
seems that the inclusion of  second-order LV would increase the complexity 
of  the model. The results are presented in Table 6.

Table 6 Results of  the structural model (n = 200)

Structural  
relation

f²
Structural 
coefficient

Standard 
error

t-value p-value R² 

LEARN_CULTURE 
-> financial_perf

0.597 0.612 0.046 13.187 0.000 0.374

Note: p-values estimated by bootstrapping with 5000 repetitions.

In this example, the seven dimensions of  the DLOQ-A were used 
to measure the learning culture, and this variable explained 37.4% of  the 
variance of  the performance, confirming the only hypothesis proposed (re-
membering that in this model, the other relationships are measurement).

When the number of  indicators/LV is equal for all LVs (as in this 
example), the approach of  the repeated indicators can be used, but when 
the quantities of  indicators/LV in the first-order LV are very different, this 
approach is not recommended because the first-order LV that has more 
indicators will result in a stronger relationship with the second-order LV 
(factor loading), simply because it had more repeated indicators in the sec-
ond-order LV, and the LV that has fewer indicators, will have a lower factor 
loading. 

When the number of  indicators/VL varies, it is recommended the 
two-step approach to model second-order LV, which will be presented in 
the next example.
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EXAMPLE 4 - STRUCTURAL MODEL WITH SECOND-ORDER LA-
TENT VARIABLE (TWO STEPS APPROACH)

This option must be chosen to model second-order LV when the number 
of  indicators per LV is very different (in first-order LVs). It is necessary to 
obtain the first-order LV factor scores, to save these scores in the original 
data set, to import them into SmartPLS 3 and to model the second-order 
LV as if  it were a first-order LV, using these scores for its measurement.

Specification
For this example, the model of  example 1 was run, and the factor scores 
were copied/pasted to the original data set. These scores are in the Output 
PLS algorithm:

• Final results > Latent variable > Latent variable

Other possibilities for generating the factor scores of  each first-order 
LV are:

• To perform a principal component analysis (PCA) for each LV, to 
evaluate if  the indicators are with adequate loadings and must be 
kept in the model, to generate the factor score in the PCA itself;

• Using an older method (summated rating scales), which consists 
of  generating the score for each LV as the average of  its indica-
tors. A previous analysis of  Cronbach’s alpha or PCA’s for each 
LV can help decide whether to maintain all indicators to obtain 
the scores or not. This procedure can also be related to the liter-
ature on “item parcels” (LITTLE et al., 2002).

Sometimes in the copy and paste action formatting problems can oc-
cur UK and USA format use dot as decimal point and in Brazilian many 
European countries use comma), if this occurs, a simple solution is to copy 
from SmartPLS 3 (click in “Excel Format”) and paste in the notepad and 
to replace the dots by commas, and then copy/paste to Excel. Save as .csv 
(character separated by comma) and import it into SmartPLS 3: right-click 
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on project name > import data file > ...> right-click on dataset name > 
Select Active Data File.

Another option is to use Excel features to import data: Paste > Use 
Text Import Wizard > My data has headers > Next > Tab > Next > Ad-
vanced > Decimal separator = dot; Thousands separator = comma > Ok 
> Finish.

Comparing Figure 12 with Figure 10 it is observed that the struc-
tural model is the same; only the measurement of  the second-order LV 
is different.

Figure 12 Structural model with second order LV modelled in two steps

Note 1: Learning Culture is a second order LV.

Note 2: The indicators of  LV learning culture are factor scores saved in the first step, in the 

confirmatory component analysis.

Estimation
At this point, there is no novelty; the estimation (PLS algorithm and boots-
trapping) was the same as example 2.

Evaluation and reporting
As in Example 2, the results were formatted into two tables for the measu-
rement model (Table 7a and 7b) and a table for the structural model (Table 
8), which are presented following.
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Table 7 Results of  the measurement model (n = 200)

(a) Indicators LEARN_CULTURE financial_perf

team_learning 0.857 0.549
empower 0.863 0.508
sys_connection 0.892 0.560
leadership 0.883 0.477
cont_learn 0.864 0.472
dialog_inquiry 0.881 0.589
sys_capture_share 0.834 0.565
VX45 0.650 0.894

VX46 0.485 0.895

VX47 0.464 0.864
     
(b) Latent variables LEARN_CULTURE financial_perf
LEARN_CULTURE 0.868  
financial_perf 0.616 0.885
     
Composite reliability (CR) 0.955 0.915
Average variance extracted 
(AVE)

0.753 0.782

Note: Panel (a) = crossloading matrix

 Panel (b) = matrix of  correlations between the LV, with the square root of  the AVE 

in the diagonal.

Table 8 Structural model results (n=200)

Structural 
relation

f²
Structural 
coefficient

Standard 
error

t-value p-value R² 

LEARN_ 
CULTURE ->  
financial_perf

0.613 0.616 0.044 13.959 0.000 0.380
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Since all first-order LVs had three indicators (equal quantity of  in-
dicators/LV), the approach of  repeating first-order LV indicators in sec-
ond-order LV and the two-step approach yielded identical results for prac-
tical purposes (R² equal to 0.374 and 0.380, respectively).

Both approaches solved the problem of  multicollinearity found in 
example 2, requiring a modification in the conceptual model: to define the 
second-order LV and to revise the hypothesis (structural relation).

This procedure (grouping multicollinear variables) is recommended 
by Hair Jr. et al. (2016, position 4541), but also uses the same logic of  what 
is known as principal components regression (COHEN et al., 2003, p.428).
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EXAMPLE 5 - STRUCTURAL MODEL WITH MEDIATION (DIRECT, 
INDIRECT AND TOTAL EFFECTS)

Examples 5 and 6 are based on the European Customer Satisfaction Index 
(ECSI) model, whose data and design are available on the SmartPLS 3 website 
(RINGLE et al., 2015) in the “Resources> SmartPLS Project Examples” tab. 
This example is already a “classic” because since 2005 it has been used for the 
teaching of  PLS-SEM and has as reference the article by Tenenhaus et al. (2005).

Specification
This example will not be modified in any way (Figure 13), only the way in 
which the software estimates the indirect and total effects will be presen-
ted, so that it is possible to evaluate if  the mediation is full (when indirect 
effect is significant but direct is null) or partial (when indirect and direct 
effects are significant).
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Figure 13 ECSI model - direct and indirect effect of  Expectation on Satis-
faction

Source: Ringle et al. (2015).

Note 1: Direct effect: Expectation  Satisfaction

 Indirect effect: Expectation  Value à Satisfaction

 Indirect effect: Expectation  Quality  Value  Satisfaction

 Indirect effect: Expectation  Quality à Satisfaction

Note 2: Expectation and Satisfaction are in different colour only to highlight that, in this 

example, the focus of  the analysis is in the relationships (direct, indirect and total) between 

them.

Estimation
Strictly speaking, the measurement model and then the structural model 
should be evaluated. By limiting space, no adjustment will be made to the 
measurement model (on the one hand, if  the objective is to compare the 
index - satisfaction score - from one survey to another, it is necessary that 
the measurement model be the same - configurational invariance - and, 
on the other hand, if  the analyzes presented in Example 1 are performed, 
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severe problems of  convergent and discriminant validity will be identified, 
see for yourself ).

For the purpose of  this example, consider the following situation: 
the path coefficient between Expectation and Satisfaction is not significant 
(0.063, p>0.20), so does Expectancy not influence Satisfaction?

Evaluation and reporting
To evaluate whether there is mediation and whether it is total or partial, 
direct, indirect and total effects are evaluated, as shown in Table 9.

Table 9 Mediation, direct and indirect effects

Direct effect Indirect effect Mediation

Significant (p < 0.05) Not significant (p > 0.05) There is no mediation
Significant (p < 0.05) Significant (p < 0.05) Partial mediation

Not significant (p > 0.05) Significant (p < 0.05) Full mediation

The formatting of  Table 10 is made from the bootstrap results, high-
lighting that the amount of  results (indirect effects) is large, so the work is 
more to select those that interest:

• Output Bootstrapping > Final Results:
• Path coefficients > Excel format
• Paste into an Excel spreadsheet
• Specific indirect effects > Excel format
• Paste into an Excel spreadsheet
• Total effects > Excel format
• Paste into an Excel spreadsheet
• Copy/paste the necessary lines
• Exclude the column “Sample Mean (M)”
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Table 10 Specific indirect effects (detailed)

Effects Coefficient
Standard  

error
t-value p-value

Direct
Expectation ->  
Satisfaction

0.063 0.050 1.25 0.213

Indirect
Expectation -> Quality 
-> Satisfaction

0.285 0.044 6.41 0.000

Indirect
Expectation -> Quality 
-> Value -> Satisfaction

0.061 0.022 2.75 0.006

Indirect
Expectation -> Value -> 
Satisfaction

0.010 0.017 0.57 0.566

Total
Expectation ->  
Satisfaction

0.418 0.058 7.24 0.000

Note: In the bootstrap output the specific indirect effects option displays the results of  all 

indirect effects, as in this table. The total indirect effects option is less detailed and shows 

only the total indirect effect (0.355, p<0.001).

Responding to the question posed at the beginning of  section 5, Ex-
pectation does not have a direct effect on Satisfaction, but has an indirect 
effect (0.355, p <0.001), that is, it is a total mediation, so it is important to 
promote satisfaction.

The results can be complemented with Figure 14, which relates the 
total effects (importance) to performance (mean scores on a scale of  0 to 
100). Here it is explicit that expectation, although not having a significant 
direct effect, has an important total effect, and only lags behind perceived 
quality in terms of  priority, which can be improved from a score of  73 to 100. 
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Figure 14 Importance-performance map (or Priority map)

Note: To get this chart:

Calculate > Importance-Performance... > Select the LV Satisfaction > Start calculation.

The coordinates of  each point can be obtained in the output in Final results > Performan-

ce / Index.
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EXAMPLE 6 - STRUCTURAL MODEL WITH MODERATION OF A 
CONTINUOUS VARIABLE

A moderating variable strengthens or weakens the relationship between 
an independent variable (IV or predictor) and a dependent variable (DV or 
criterion or endogenous). This moderator variable can be continuous (at 
least interval or considered as such) or categorical. For the first case, follow 
this example (Figure 15), and for the case of  categorical moderator follow 
the example 7 (MGA - Multi-group analysis).

Figure 15 Representation of  the moderator variable

Note: To understand the need for the multiplicative term, simply compare the models 

with and without moderation:

Without moderation: y = a + b
1
x  se  x = 0, y = a

With moderation: y = a + b
1
x + b

2
z + b

3
xz   se x = 0, y = a + b

2
z    b2 moves the line 

vertically.

Without moderation: y = a + b
1
x   = b

1
 

With moderation:  y = a + b
1
x + b

2
z + b

3
xz    = b

1
 + b

3
z    b3 changes the slope of  

the line.

Specification
The relationship between IV and DV may be positive or negative and the 
moderating variable may weaken or strengthen this relationship, Gardner 
et al. (2017) present several examples that may be useful to understand how 
a moderating variable would be justifiable in a model.
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The model to be used in this example is the same ECSI, including a 
moderating effect of  the Image on the relationship between Satisfaction 
and Loyalty, as was done in the presentation of  the XLSTAT-PLSPM soft-
ware (2017) and is shown in Figure 16.

Figure 16 Moderating effect of  the Image on the Satisfaction-Loyalty rela-
tionship

Note 1: To create the multiplicative term in SmartPLS 3: Right-click on the dependent 

variable> Add Moderating Effect> Select the moderator variable and the independent 

variable> Select the calculation method (*)> Ok.

(*) The “orthogonalization” method is suggested because it guarantees that there will be 

no multicollinearity between the multiplicative term and the independent and moderating 

variable.

Note 2: Image, Satisfaction, and Loyalty are in different colour only to highlight that, in 

this example; the focus of  the analysis is in the relationships (direct and moderate) among 

them.

Estimation
The estimation of  this model is performed in the usual way, as is done in 
any model and as presented in the model of  example 5. When specifying 
the multiplicative term in the previous step, SmartPLS 3 generates a sim-
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ple slope analysis, which contains three lines: one for the average value 
of  the moderator and another two with a standard deviation above and 
below the average. 

For v.2 of  SmartPLS, or other software that does not have this graph, 
it can be generated from the results of  the bootstrap (structural coefficients) 
and the worksheets developed by Dawson (2014), which are recommended 
by Hair Jr. et al. (2016).

Evaluation and reporting
The result of  the moderating effect is included in the structural model 
evaluation table, as was done in Tables 4, 6 and 8. Only the result of  the 
moderating effect was shown in Table 11 because of  space constraint.

Table 11 Results of  the structural model

Structural  

relation

Gardner  

et al. (2017, 

p.614)

f²
Structural 

coefficient

Standard 

error
t-value p-value

Moderating Effect 

1 -> Loyality
XZ 0.030 -0.103 0.036 2.88 0.004

Satisfaction -> 
Loyality

X 0.193 0.468 0.085 5.48 0.000

Image -> Loyality Z 0.032 0.184 0.078 2.36 0.018
COMP -> Loyality   0.007 0.072 0.057 1.26 0.206

Legend: X = Independent variable; Z = Moderator variable; XZ = multiplicative term or 

term of  interaction.

Note 1: Gardner et al. (2017, p.614) assist in the interpretation of  the moderation results 

from the X, Z, and XZ signals.

Note 2: Incomplete table; it includes just the structural relations with loyalty (adjusted R² 

= 46.4%), which is the focus of  this example.

As was quoted in Example 2, to evaluate the effect size of  the struc-
tural coefficients is used the Cohen (1988) classification: f² = 0.02 = small; f² 
= 0.15 = medium; f² = 0.35 = large. However, when it comes to the moder-
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ating effect, Hair Jr. et al. (2017) suggest the classification of  Kenny (2015): 
f² = 0.005 = small; f² = 0.010 = medium; f² = 0.025 = large. Therefore, the 
moderating effect in this example is significant and large.

Another important result of  the moderating effect is the Figure 17a:

• the upper (green) line represents the relationship between satis-
faction and loyalty when the image has high values (1 standard 
deviation above the mean). For high image values, the satisfac-
tion-loyalty relationship is weaker. According to Gardner et al. 
(2017, p.614): “Weakening: Z moderates the positive (negative) 
relationship between X and Y, so that the relationship becomes 
weaker as Z increases.”

• the bottom line (blue) represents the relationship between sat-
isfaction and loyalty when the image has low values (1 standard 
deviation below the mean). For low image values, the satisfac-
tion-loyalty relationship is stronger.

• Figure 17b contains the same graph as Figure 17a, but may be 
more suitable than the first in the case of  Black & White articles. 
To generate Figure 17b, the structural coefficients of  Table 11 
were entered in Dawson’s “two-way interactions – standardized” 
worksheet (2014).
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Figure 17 Graph of  the moderating effect of  the Image on the Satisfaction-
-Loyalty relation

(a) Graph generated in SmartPLS 3 when including a moderator variable

(b) Graph generated with the structural coefficients of  Table 11 and  

Dawson worksheet (2014)

Note 1: Graph 17a is generated in SmartPLS 3 and is presented in the output of  the PLS 
algorithm in the tab: Final Results > Simple slope analysis.
Note 2: The structural coefficients of  Table 11 were entered in Dawson’s two-way interac-
tions - standardized worksheet (2014) to provide graph 17b.
Note 3: The inclusion of  quadratic effects in SmartPLS 3 is done similarly to the interac-
tion term, but the software does not generate the graph for quadratic effect. It can be 
prepared with one of  Dawson’s worksheets (2014).
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EXAMPLE 7 - STRUCTURAL MODEL WITH MODERATION OF A CA-
TEGORICAL VARIABLE – MGA

This type of analysis is used when there is a priori a variable that will be 
used to define the groups to be compared (observed heterogeneity), for 
example, gender, country, sector, etc.

The model used in this example remains the ECSI, but the data used 
are those available in the package plspm of the software R (SANCHEZ, 
2013). They are from a Spanish research, which includes the gender vari-
able and will be used as a categorical moderator in this example. To obtain 
the data, install the R software and run the following script:

install.packages(“plspm”, dep=T)
library(plspm)
data(satisfaction)
write.csv(satisfaction, “ECSI_mga.csv”, row.names=F)
getwd() # to see in which folder the .csv file was saved 

Specification
The structural model is the same as in Figure 13, except that there is no 
LV Complaint, and now the gender variable will be used as a categorical 
moderator in the multi-group analysis (MGA).

In this type of analysis the objective can be: (i) to show that the 
measurement model is invariant (or equivalent) between the groups, in 
the sense that the same construct is measured equally in different groups 
(MILLSAP, 2011), (ii) to assess if the relations between the constructs 
(structural coefficients) vary depending on the group (HAIR JR et al., 2016).

Estimation
The modelling is done in SmartPLS 3 like the previous ones but must be 
added the information of which variable will be used as a categorical mo-
derator, which will define the groups to be compared. To do this, just do 
as in Figure 18: double-click on the data set icon> Generate data groups > 
Select the variable “gender” > Ok. 
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Figure 18 Defining the groups to be used in the multi-group analysis (MGA)

Although it is not the recommended method for moderators that 
are numerical variables, if  it is decided to discretize a numerical variable 
(dichotomize or polytomize) to use it as the variable that will define the 
groups, this can be done directly in SmartPLS 3 as follows:

double-click the dataset icon> Add data groups> Name the category 
of  the group > Select the variable > Define the criteria for inclusion 
in the category > Ok (Figure 19), and repeat the same procedure for 
the other categories to include all the sample (collectively exhaustive 
and mutually exclusive categories).

Figure 19 Dichotomization of  a numerical variable for use in the MGA

Note: This dataset is not the same as that used in the MGA examples (n = 310).
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After the groups are defined, it is possible to execute the MGA in two 
ways, permutation being the most recommended because it has a measure-
ment invariance test (MICOM) to evaluate the invariance of  the measure-
ment model:

i. MGA: Calculate > Multi-group Analysis (MGA) > Select a genre 
in each group > Start calculation.

ii. Permutation: Calculate > Permutation > Select a genre in each 
group > Start calculation.

Evaluation and reporting
First, it is necessary to evaluate if  the measurement model is invariant from 
one group to another. The invariance can be evaluated from a weaker form 
(configurational invariance, which means that the same indicators are used 
to measure the same constructs in different groups), to something more 
restricted as the indicators show the same factor loads in different groups 
etc. For further study on this topic, we suggest Henseler et al. (2016) for 
models estimated by PLS-SEM and Little (2013) for models estimated by 
SEM covariance based.

In this example, the configurational invariance is guaranteed from the 
beginning (step 1), since the two groups and their differences are estimated 
in the same round. In step 2 the compositional invariance (MICOM) is eval-
uated, which is accepted if  the correlation between the scores for each con-
struct is equal to 1, when using the outer weights of  group 1 and group 2. 

In Figure 20 it is observed that the compositional invariance was not 
obtained for the Value construct, and one of  the following options must be 
chosen:

• If  the difference is due to a few indicators, they could be excluded 
from the model;

• Define a priori weights for each indicator (fixed values);
• Exclude the entire construct from the model, with some post hoc 

justification/explanation;
• Do not continue the comparison and analyse the groups sepa-

rately.
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Figure 20 MICOM results

Original 
Correlation

Correlation  
Permutation Mean

5.0%
Permutation 

p-Values
Expectation 0.999 0.999 0.997 0.573
Image 0.996 0.997 0.991 0.292
Loyalty 0.995 0.996 0.990 0.303
Quality 0.999 0.999 0.998 0.465
Satisfaction 1.000 1.000 0.999 0.448
Value 0.994 0.999 0.996 0.008

Note: This result is displayed in the permutation output > Quality criteria > MICOM

To evaluate the indicators of  each construct in the output of  Permu-
tation (Final results > outer loadings and outer weights) we observe the 
following significant differences between the groups:

• Outer loading: indicator val3 presented a difference equal to 
0.306 (p = 0.002)

• Outer weight: indicator val3 presented a difference equal to 0.091 
(p = 0.013) and val1 was equal to 0.115 (p = 0.004).

From these results, it was decided to exclude the indicator val3 and 
run the permutation again, which resulted in the acceptance of  the com-
positional invariance for all constructs (configurational + compositional = 
partial invariance), which allows the comparison of  the structural coeffi-
cients (in step 3 of  the MICOM are compared the means and variances to 
establish the total invariance). 

Finishing the analysis, it is observed in Figure 21 two structural coef-
ficients that were different (Image  Loyalty; Satisfaction  Loyalty). The 
MGA analysis can complement the results of  the Permutation because it 
presents the coefficients and p-values for the two groups.
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Figure 21 Permutation results (difference of  structural coefficients)

Path Coefficients

Matrix Copy to 

Clipboard:

Path... Path...
Path Coefficients 

Original Differenc...
Path... 2.5% 97.5%

Permutation 

p-Value

Expectation -> Quality 0.858 0.837 0.021 0.000 -0.089 0.080 0.618

Expectation -> Satisfaction 0.058 -0.047 0.105 0.004 -0.238 0.277 0.449

Expectation -> Value 0.080 0.170 -0.090 -0.001 -0.315 0.304 0.551

Image -> Expectation 0.483 0.619 -0.136 0.004 -0.190 0.200 0.172

Image -> Loyalty 0.082 0.471 -0.389 0.013 -0.285 0.295 0.007

Image -> Satisfaction 0.162 0.220 -0.057 0.004 -0.206 0.213 0.588

Quality -> Satisfaction 0.028 0.234 -0.206 -0.002 -0.382 0.330 0.252

Quality -> Value 0.616 0.678 -0.062 0.002 -0.311 0.331 0.708

Satisfaction -> Loyalty 0.716 0.260 0.456 -0.010 -0.325 0.275 0.001

Value -> Satisfactio 0.689 0.498 0.191 -0.007 -0.334 0.307 0.255

Note: This result is displayed in the permutation output > Final Results > Path coeffi-

cients.

If  there are more than two groups to compare, multiple compari-
sons will be necessary. In this case, the Bonferroni correction is indicated, 
for example: if  there are three groups to be compared (ABC), there will be 
three comparisons (AB, AC, BC), so the p-values should be multiplied by 3 
(or the level of  significance - α - should be divided by 3, for example, 0.05/3 
= 0.0167) to assert that the difference is significant at 5%. For four groups, 
there will be six comparisons (AB, AC, AD, BC, BD, CD), so the p-values 
should be multiplied by 6 or α = 0.05/6 = 0.00833, to assert that the differ-
ence is significant 5% (HAIR JR et al., 2016). 

More recommendation than the conclusion
The article presented does not have a “closure” or a set of  the findings, be-
cause it had a basis of  presentation of  statistical techniques, thus forming 
an attempt to create a set of  guidelines for the use of  the PLS-SEM multi-
variate technique in other contexts and situations different from the more 
common ones.
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The increasing use of  PLS-SEM probably has as main reasons the 
types of  research that are carried out in the areas of  human, social and 
behavioral sciences, that is, they are data from attitude scales or Likert type 
(in many times) and such scales present data that are rarely adherent to the 
multivariate normal  distribution; have models that do not have very solid 
or “sedimented” theoretical bases, because in the areas of  knowledge indi-
cated the problems are more complex and difficult to structure.

Thus, the higher “plasticity” in the assumptions that support the sta-
tistical technique presented here allows the inclusion of  a wide range of  
models and variations of  these that better meet the needs of  the indicated 
areas.

Also, there is sometimes debate and some controversy over working 
with small samples, and in the introduction, a warning already has been 
added to not to use PLS-SEM with the only justification that the sample is 
small. But what is the problem of  using a small sample if  the effects found 
were significant? Briefly: 

• If  the sample is small, it will result in greater variation in results;
• When eliminating indicators with low loadings, it may be that the 

others (indicators), which are with high loadings present these 
values only because the sample is small, that is, if  the sample was 
large, the variation would be smaller, and it would be observed 
that the loadings are not so high. This discussion has been made 
as overfitting and chance capitalisation;

• Therefore, Hair Jr. et al. (2010) suggest the use of  a new sample 
if  more than 20% of  indicators are excluded.

Finally, it is understood that this article was an attempt to comple-
ment and advance in relation to the publication of  Ringle et al. (2014a; 
2014b), but learning is a work-in-process, so some videos have been pre-
pared for the examples presented in this article and are available on the 
YouTube Channel (https://bit.ly/2F7kgud), from so that interested parties 
can send questions and suggestions on the Canal itself.
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